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Chapter 1: Installing and Configuring SourceBridge

Introduction

SourceBridge is an extension that allows you to associate source control actions with SBM
items and record version control history in SBM. SourceBridge intercepts check-out,
check-in, undo check out, and add file processes to allow you to associate source files with
SBM items. The source control processes are captured and recorded in the SBM database
as well as in the source control environment.

SourceBridge can be used with integrated development environments that comply with
Microsoft Source Code Control Interface (MSSCCI) standards, such as PVCS Version
Manager. You can also use SourceBridge from within supported versions of PVCS Version
Manager.

Installing SourceBridge

SourceBridge is installed on each user's machine. Before installation, the integrated
development and source control environments must be installed and configured.

m To use SourceBridge, you must be granted the "Logon from SourceBridge" privilege.
The "Logon from SourceBridge" privilege also enables you to create, run, modify, and
delete Version Control Actions reports in the SBM User Workspace. Contact your SBM
administrator to determine if you have been granted this privilege.

m  Select the Version Control History check box on the Display tab of your user profile in
SBM. This setting allows you to view version control history in the SBM User
Workspace.

= SBM must be configured to allow legacy access for Remote Administration and API
when using an Authentication mechanism that has this as an option (SBM Session
Cookies). In SBM Configurator, on the General tab, select Allow legacy access for
Remote Administration and API.
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Source Control Registry Settings

Source Control Registry Settings

The SourceBridge installation modifies the system registry to allow SourceBridge to insert
itself between the integrated development environment and source control.

Understanding the Registry Settings

The following figures show how the SourceCodeControlProvider key is displayed before
and after SourceBridge has been installed.

The following figure shows the Windows registry editor before the SourceBridge
installation. The ProviderRegKey points to the source control provider.
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Chapter 1: Installing and Configuring SourceBridge

The following figure shows is the Windows registry editor after the SourceBridge
installation. The ProviderRegKey points to SBM. The prior setting of ProviderRegKey is
saved in SerenaCopyofOriginalProviderRegKey.
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Source Control Registry Settings

The SourceBridge installation also adds registry keys to the

Local Machine\Software\TeamShare\SourceBridge folder, as shown in the following
figure. The UnderlyingSCC key points to the source control provider that is intercepted by
SourceBridge.
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Troubleshooting the Installation

When SourceBridge is installed, the ProviderRegKey points to the

Local Machine\Software\TeamShare\SourceBridge folder. If SourceBridge is
reinstalled without first uninstalling, the ProviderRegKey value is copied without first
checking to see if SourceBridge is already installed and your development environment
may be unable to locate your source control provider. Repeated reinstallations may crash
the development environment. To fix this problem, uninstall SourceBridge through the
Add/Remove Programs Properties dialog box located in the Windows Control Panel, then
reinstall.

In addition, if you upgrade or re-install your source control tool, you must update the
ProviderRegKey to point to the Local Machine\Software\TeamShare\SourceBridge
folder.
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Configuring SourceBridge

Before using SourceBridge, you must provide the SBM Web server location, your SBM
login ID and password, and your source control provider. These settings are made on the
System Settings tab of the Settings dialog box, which automatically opens when you try
to check a file in or out for the first time after installing SourceBridge.

You can also open the Settings dialog box manually using the following methods:
m  Click the Source Control icon located on your IDE toolbar.

m  Depending on your IDE, select Source Control from the Project menu in the IDE. For
example, in Microsoft Visual C++, select Source Control from the Project menu, and
then select your source control provider, such as PVCS Version Manager.

m In PVCS Version Manager, select SourceBridge from the Tools menu.

When the SourceBridge dialog box opens, click the Settings button to open the Settings
dialog box to the System Settings tab.
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Configuring System Settings

The following options can be set on the System Settings tab of the Settings dialog box.

PVCS Version Manager ScurceBridge - Settings et

System Setlings  User Settings

SBM Server Information

SBM Server: |I‘rttp:ffsewemame:pu:urt |

SBM Login ID: lioe |

SBM Password: | |

[ ]Connect via Proxy Server;

Werfy Connection...

Underying Source Code Control Provider

Launch PVCS Version Manager SCC...

Switch Provider To: w

* Changing providers will not take effect urtil you restart your IDE.

Concel | [_riop

m  SBM Server

Type the name, IP address, or URL of the SBM Web server. For a secure connection,
type the URL of the SBM Web server, including the https://secure protocol.

= SBM Login ID

Type your SBM login ID.
= SBM Password

Type your SBM password.
s Connect via Proxy Server

Select this check box to connect to the Web server through a proxy server. You may
also enter a URL here.

m Verify Connection

Click this button to verify that SourceBridge can connect to the SBM Web server. If
SourceBridge is unable to connect to the SBM server, modify information in the SBM
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Server, Login ID, and Password boxes as needed or verify with your SBM
administrator that the Web server is running.

Note: If you are using SourceBridge within the PVCS Version Manager Windows
client, the following options are not available.

= Launch Source Control Provider

Click this button to launch the source control provider configured to work with
SourceBridge.

m  Switch Provider to

Select the source control provider you want to use from the drop-down list. This list is
populated with all source control applications that comply with MSSCCI standards that
are installed on the your machine. You must restart your development environment
after selecting a new source control provider.

Configuring User Settings

The following options are available on the User Settings tab of the Settings dialog box.

Note: Your administrator can override certain settings. Settings that have been
overridden by your administrator are disabled and marked with an asterisk. Settings that
cannot be changed are disabled.

PYCS Version Manager SourceBridge - Settings x

System Settings  User Settings

Preferences
Show Association Dialog on Checkout
[ ] A==ociation Required
Show Association Dialog on Checkin
[ ] Association Required
Show Only if Mo Associations
[ ] Cleanup Associations on Undo Checkout
Tag Source Contral Comment with Associations
Include Change User Info
{®) Before Existing Comment
() Mter Existing Comment
Tag: |Sid(Stableid, Srecid) Stile

] Ask for Transition {during Checkin or Uncheckout)
[ ] Guick Association {automatically associate selected results f no as=ociations)
lIse Version Labels on Checkin

Your administrator may set Source Bridge options on certain project databases
that will ovemide these settings.

Cancel Help
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Configuring SourceBridge

Show Association Dialog on Checkout

Select this check box to open the SourceBridge - Check Out dialog box each time
source files are checked out. This enables you to associate SBM items with the files
being checked out. The Show Association Dialog on Checkout check box is selected by
default. Note that this setting has no effect when SourceBridge is used through the
PVCS Version Manager Windows client.

¢ Association Required

This check box is enabled if the Show Association Dialog on Checkout check box is
selected. Select the Association Required check box to require that at least one
SBM item is associated with the file or files being checked out. By default, this
check box is cleared.

Show Association Dialog on Checkin

Select this check box to open the SourceBridge - Check In dialog box each time
source files are checked in. This enables you to associate new SBM items with the files
or to modify associations made at check in. This option also opens the SourceBridge -
Add to Source Control dialog box each time you add files to source control. By default,
the Show Association Dialog on Checkin check box is selected. Note that this setting
has no effect when SourceBridge is used through the PVCS Version Manager Windows
client.

¢ Association Required

This check box is enabled if the Show Association Dialog on Checkin check box is
selected. Select the Association Required check box to require that at least one
SBM item is associated with the file or files being checked in or added to source
control. By default, this check box is cleared.

e Show Only if No Associations

This check box is enabled if the Show Association Dialog on Checkin check box is
selected. Select the Show Only if No Associations check box to open the
SourceBridge Check In dialog box if file or files being checked in are not already
associated with an SBM item. By default, this check box is selected.

Cleanup Associations on Undo Checkout

Select this check box to automatically remove check out records from SBM items
when an undo-checkout operation is performed. Clear this check box to log undo
checkout records and to store check out records in SBM when an undo checkout
operation is performed. By default, the Cleanup Associations on Undo Checkout check
box is cleared.

Tag Source Control Comment With Associations

Select this check box to record SBM item associations in the comments area for each
file's source control properties for some source control environments.

¢ Include Change User Info

Select this check box to include your SBM user name and login ID in the comments
area for each file you associate with items as you perform check out and check in
operations. By default, this check box is selected.

o Before Existing Comment

Select this option to add SBM association information to the beginning of existing
comments.
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o After Existing Comment

Select this option to add SBM association information after existing comments.
This option is selected by default.

e Tag

Specify a format for association information added to comments. The tags can be
made up of text and the following data identifier tags:

« $id
Returns the Item ID for the SBM item.
+ $ownid

Returns the login ID of the user who owns the SBM item at the time of the
association.

 $project

Returns the name of the project in which SBM items reside at the time of the
association.

+ $recid
Returns the SBM item's database record ID.
+ $tableid

Returns the SBM item's database table ID. The default tag is
$id($tableid, $recid) $title.

m  Ask for Transition (During Checkin or Uncheckout)

Select this check box for SBM to prompt you to transition items on completion of
associated check in and undo check out operations. By default, this check box is
Cleared.

= Quick Association

Select this check box to associate SBM items selected in the Results list on the
SourceBridge Check In or SourceBridge Check Out dialog boxes with the files being
checked in or out. The enables you to quickly associate items without clicking the
Associate button in the Associations area. By default, this check box is cleared.

m Use Version Labels on Checkin

This setting is available when PVCS Version Manager is used as the underlying source
control system. Select this check box to add a version label to the file that contains
the SBM Item ID when you check in files.
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Chapter 2: Using SourceBridge

Introduction

SourceBridge enables you to associate source control actions with SBM items from within
the development environment and record these actions in SBM and the source control
environment. You can also search for SBM items and launch SBM.

Using SBM in SourceBridge

The SourceBridge dialog box enables you to work with SBM items from within the
integrated development environment or from within PVCS Version Manager. Specifically,
you can use the SourceBridge dialog box to:

m  Search for items you have privileges to transition and launch SBM to open to those
items.

Note: SBM items are associated with source control files using the SourceBridge -
Check In, SourceBridge - Check Out, and SourceBridge - Add to Source Control dialog
boxes. For details see page 17.

m Launch the SBM User Workspace.
m Launch your source control application, if applicable.

m  Access SourceBridge system and user settings.

14 PVCS Version Manager



Using SBM in SourceBridge

PVCS Version Manager SourceBridge H

Project (Indudes Sub-Projects): | Animation Pro R |

Keyword(s): | |

Item Id: | | Filter on Active/Inactive:

Show Only Ttems I Own @active  Olnactve  (OBoth

[ ] Append Search Results to List

Search Results:
Id Title Owner Project State ™
BUGDOD122 Swirl animation is not working correctly joe Animatio...  Ewvaluati.
BUGOOD128 Scanning images don't work with saved im...  joe Animatio...  Ewvaluati.
BUGO00133 Performance joe Animatio...  Evaluati.
BLIGO00 140 I'm losing frames of animation during a save. joe Animatio... Evaluati.
BUGOD0 193 404 page not found error joe Animatio... Evaluati.
BUGD00054 Program shuts down laura Animatio...  Fixing Is
BUGO00035 Animation takes too long to start laura Animatio...  FixingIs ,
< - ' >

Item Details. ..
Launch SBM ... Launch PVICS Version Manager SCC... Settings...
Close Help

You can open the SourceBridge dialog box using the following methods:
m  Click the Source Control icon located on your IDE toolbar.

m  Depending on your IDE, select Source Control from the Project menu in the IDE. For
example, in Microsoft Visual C++, select Source Control from the Project menu, and
then select your source control provider, such as PVCS Version Manager.

m In PVCS Version Manager, select SourceBridge from the Tools menu.
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Chapter 2: Using SourceBridge

The following options are available on the SourceBridge dialog box:

Project (Includes Sub-projects)

This option enables you to filter searches by projects in which you have privileges to
transition items. If a parent project is selected from the drop-down list, items are
returned from the parent project and any of its sub-projects.

Keyword(s)

Use the Keyword box to search for information in Text fields that are set up for
keyword searching by your administrator. Keyword searches typically apply to the
Title and Description fields, but may include other fields as well. Type the keyword you
want to use for the search in the Keyword box. Separate multiple keywords with a
space. To find an exact phrase, enclose the phrase with quotation marks. Asterisks (*)
serve as wildcard characters.

Item ID

To find items by ID, type the Item ID in the box. The following criteria applies to Item
ID searches:

e Prefixes specified with the ID number are ignored.

¢ Leading zeros on the ID number may be left off your search criteria. For example,
to find item ID number "BUG00017," type "17."

o Wildcard characters are automatically prepended and appended to your search
criteria.

o If you provide search criteria in the Keyword(s) and Item ID boxes, the Keyword
criteria is ignored, and the search is based on the Item ID criteria.

o If multiple items with the same ID number are found in a project and its
descendant, each of these items is added to the Search Results list.

o If a single digit is typed in the Item ID box, each item in the database with an Item
ID that includes that digit is returned. For example, if 5 is typed, items with ID
numbers 5, 52, 75, and so on are returned.

Filter on Active/Inactive

This option enables you to list active items you can transition, inactive items you can
transition, or both.

Show Only Items I Own

Select this check box to list all items you own in the specified project and its sub-
projects. Clear this check box to list all items you can transition in the specified
project and sub-projects. If the Show Only Items I Own check box is cleared, you
must specify a keyword or item id as search criteria.

Append Search Results to List

Select this check box to add search results to the existing Search Results list. Clear
this check box to replace the Search Results list with search results.

Search
Click Search to search for SBM items based on specified criteria.
Search Results

Items meeting the search criteria are listed in the Search Results list. The list displays
the Item ID, Title, Owner, Project, State, and Active/ Inactive status for each item.

16
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Associating Items With Source Control Actions

m Item Details

Select an item from the Results list, and then click Item Details to open the SBM User
Workspace to that item.

= Launch SBM
Click this button to launch SBM. You can then work with reports, submit items, etc.
= Launch Source Control Provider

Click this button to launch the source control provider configured to work with
SourceBridge.

m  Settings

Click this button to open the Settings dialog box and set system and user settings.

Associating Items With Source Control Actions

SourceBridge leverages the development environment's integration with version control
software; therefore, unless you are using Version Manager, all files must be checked in
and checked out from within the IDE to be recorded in SBM. If you are using Version
Manager and SourceBridge is properly installed and configured, file operations performed
from the source control environment are recorded in SBM.

The process for checking files in and out depends on your source control application and
integrated development environment.

Associating SBM Items With Check-Out Actions

Depending on your user settings, the SourceBridge - Check Out dialog box opens when
you check out files from the IDE or PVCS Version Manager. If you are using PVCS Version
Manager, you can also click the Associate Issues button on the Check Out File dialog box
to open the SourceBridge - Check Out dialog box.

The SourceBridge Check Out dialog box is used to associate SBM items listed in the
Results list with source files being checked out. The check-out actions are then recorded
in the SBM database and can be viewed in the Version Control History section of
associated items in SBM if you have selected the Version Control History display option in
your user profile. Depending on your user settings, these actions are also recorded in the
source control environment. For details see "Configuring User Settings" on page 10 and
"SBM Data in the Source Control Tool" on page 24.

TIP Click the Launch SBM button to open the SBM User Workspace.
To associate SBM items with files on check out:

1 Using the search mechanisms described in Search Options, locate SBM items to
associate with files being checked out.

2 Associate SBM items with the files being checked out, as described in Association
Options.

3 Click Complete to finish your action or Cancel to abort your action.

SourceBridge User’s Guide 17
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Associating SBM Items With Check In Actions

Depending on your user settings, the SourceBridge - Check In dialog box opens when you
check files in from the IDE or from PVCS Version Manager. For details see "Configuring
User Settings" on page 10.

If you are using PVCS Version Manager, you can also click the Associate Issues button on
the Check In File dialog box to open the SourceBridge - Check In dialog box.

TIP Tip: Click the Launch SBM button to open the SBM User Workspace.

1 Using the search mechanisms described in "Search Options" on page 20, locate SBM
items to associate with files being checked in.

2 Associate SBM items with the files being checked in, as described in "Association
Options" on page 21.

3 Click Complete to finish your action or Cancel to abort your action.

Transitioning Items On Check In or Undo Checkout

You can transition items upon completion of associated check in and undo check out
operations.

If you are associating multiple SBM items with the version control operation, SourceBridge
prompts you to transition each item individually. This enables you to select different
transitions for individual items as needed. If required fields need data, SourceBridge
prompts you to finish the transition in SBM. SourceBridge also prompts you to finish the
transition in SBM if you selected a special transition type, such as Copy, Post Item, or
Publish Problem.

If multiple files are associated with an SBM item, you are prompted to transition the item
when you check in the last file or you "undo" the check out on the last file.

To use the transition feature, you must select the Ask for Transition check box on the User
Settings tab of the Settings dialog box. For details see "Configuring User Settings" on
page 10.

18
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To transition items using SourceBridge:

1 After the file check in or undo check out operation completes, the SourceBridge
Transition Item dialog box opens. The Item ID and Title of the first item selected are
shown in the Item Information area.

PVCS Version Manager SourceBridg.. — >

Itemn Information

BUGOO0D0GY

| Texture image conversion

Available Transitions

Close ~
Copy

Defer

Delete

Fix

Meed Maore Info

P4 Update
_, W

| Launch Browser. .. I

Execute Skip Help

2 Select the appropriate transition from the Available Transitions list, and then click one
of the following options:

Launch SBM

Click this button to launch the SBM User Workspace to the Transition form for this
item. You can then update items as needed and transition them manually.

Execute

Click this button to transition the selected item. Click Yes to launch SBM and finish
the transition. Click No to cancel the transition.

Note: The version control operation is completed before the transition prompt is
given, so cancelling the transition does not cancel the version control operation.

Skip

Click this button to record the version control operation in SBM without
transitioning the item.
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Associating SBM Items With Add to Source Control
Actions
Depending on your user settings, the SourceBridge - Add to Source Control dialog box

opens when you add files to source control, enabling you to associate SBM items with
these items. For details see "Configuring User Settings" on page 10.

TIP Click the Launch SBM button to open the SBM User Workspace.
To associate SBM items with files being added to source control:

1 Using the search mechanisms described in "Search Options" on page 20, locate items
to associate with files being added.

2 Associate SBM items with the files being added, as described "Association Options" on
page 21.

3 Click Complete to finish your action or Cancel to abort your action.

Search Options

Search options are used in the SourceBridge Check Out, SourceBridge Check In, and
SourceBridge - Add to Source Control dialog boxes. The following search options are
available:

m  Project (Includes Sub-projects)

This option enables you to filter listed items by projects in which you have privileges
to transition items. If a parent project is selected from the drop-down list, items are
returned from the parent project and any of its sub-projects.

m  Keyword(s)

Use the Keyword box to search for information in Text fields that are set up for
keyword searching by your administrator. Keyword searches typically apply to the
Title and Description fields, but may include other fields as well. Type the keyword you
want to use for the search in the Keyword box. Separate multiple keywords with a
space. To find an exact phrase, enclose the phrase with quotation marks. Asterisks (*)
serve as wildcard characters.

m Item ID

To find items by ID, type the Item ID in the box. The following criteria applies to Item
ID searches:

o Prefixes specified with the ID number are ignored.

e Leading zeros on the ID number may be left off your search criteria. For example,
to find item ID number "BUG00017," type "17."

o Wildcard characters are automatically prepended and appended to your search
criteria.

¢ If you provide search criteria in the Keyword(s) and Item ID boxes, the Keyword
criteria is ignored, and the search is based on the Item ID criteria.

o If multiple items with the same ID number are found in a project and its
descendants, each of these items is added to the SourceBridge Check Out list.

20
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o If a single digit is typed in the Item ID box, each item in the database with an Item
ID that includes that digit is returned. For example, if 5 is typed, items with ID
numbers 5, 52, 75, and so on are returned.

m Filter on Active/Inactive

This option enables you to list active items you can transition, inactive items you can
transition, or both.

m  Show Only Items I Own

Select this check box to list all items you own in the specified project and its sub-
projects. Clear this check box to list all items you can transition in the specified
project and sub-projects. If the Show Only Items I Own check box is cleared, you
must specify a keyword or item id as search criteria.

m  Append Search Results to List

Select this check box to add search results to the existing Results list. Clear this check
box to replace the Results list with search results.

m  Search
Click Search to search for SBM items based on specified criteria.
m  Results

Items meeting the search criteria are added to the Results list. The list displays the
Item ID, Title, Owner, Project, State, and Active/Inactive status for each item.
Double-click an item to add it to the Associations list, or select an item, and then click
Associate.

m Item Details

Select an item from the Results list, and then click Item Details to open the SBM User
Workspace to that item.

Association Options

Association options are used in the SourceBridge Check Out, SourceBridge Check In, and
SourceBridge - Add to Source Control dialog boxes. The Associations area enables you to
associate files being added, checked in, or checked out with SBM items in the Results list.
Files that are being checked out, checked in, or added to source control are listed under
the All Files root folder in the Associations list. Once SBM items are associated with the
files, the items are listed under each file.

TIP SourceBridge remembers the last SBM item or items associated with source files by
automatically selecting them the next time a file is checked out or added to source
control. When you check items in, SourceBridge automatically remembers the last item
associated with source files if you have opted not to associate items with files on check
out. If an item has been closed or you no longer own it, it does not automatically show up
in the Results list.
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The following Association options are available:
m  Associate

Associate selected files in the Associations list with SBM items in the Results list by
selecting the files, and then clicking Associate. Multiple items can be selected by
pressing CTRL and clicking each item. Items are associated with files as follows:

o If the All Files root folder is selected, the association is made for all files in that
folder.

o If files are selected under the root folder, the association is made for the selected
files.

o If an SBM item is selected and no files are selected, the Associate button is
disabled.

Note: If you associate an SBM item and a file at check in, the version control
record in SBM does not contain any check out information.

m  Unassociate

Remove SBM item associations from files by selecting files or items in the Associations
list, and then clicking Unassociate. Items are unassociated from files as follows:

o If the All Files root folder is selected, you are asked if you want to remove all
associations for all files. Click Yes to remove associations; click No to keep
associations intact.

o If afile is selected, you are asked if you want to remove all associations for the
file. Click Yes to remove associations; click No to keep associations intact.

o If an SBM item is selected, it is moved from the Associations list.

Note: If you remove the association between an item and a file during check in,
the version control record is deleted from SBM.

m Item Details

Select an SBM item that is associated with a file, and then click Item Details to launch
SBM to that item.
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Accessing SourceBridge Information in SBM

You have two methods of accessing SourceBridge information in SBM:
= Version Control History

The version control history associated with each primary item can be viewed in the
Item Details frame for that item. See "Version Control History" on page 23.

m  Version Control Actions Report

This report type allows you to generate reports based on items associated with files
checked in or checked out, date ranges, and users performing version control actions
via SourceBridge. See "Version Control Actions Report" on page 23.

Version Control History

In SBM, all checkout and check-in operations performed using SourceBridge are displayed
in the Item Details page for individual primary items and can be viewed if you select the
Version Control History check box in your SBM user profile. If you choose to record undo
check out operations, these are recorded as well. If you select the Cleanup Associations
on Undo Checkout option in your SourceBridge user settings, however, all check out
associations are deleted.

The Version Control History section contains names of the files associated with an item,
the date and time files were checked in and out, the SBM user who performed the source
control action, and comments associated with check-in actions. Depending on your source
control tool, the version number of the file associated with the SBM item may be displayed
as well.

SourceBridge does not need to be installed for you to view the Version Control History in
the SBM User Workspace, but if your application uses custom forms, the Version Control
History section must be included on the form. If you cannot view the Version Control
History section, contact your system administrator.

NOTE If your administrator grants appropriate privileges, you can add, modify, and
delete version control actions, also referred to as file associations, from within SBM.

Version Control Actions Report

Version control actions can be retrieved by Version Control Actions reports. Version

Control Actions reports allow you to access information pertaining to source control files
associated with SBM primary items. You can generate reports based on items associated
with files checked in or checked out, date ranges, SBM users performing version control

actions via SourceBridge, and more. File association information is also available. For
details on working with Version Control Actions reports, refer to the SBM User's Guide.

NOTE Privileges granted by your administrator determine if you can create, run, modify,
and/or delete reports. In addition, to access Version Control Actions reports, you must be
granted the Logon From SourceBridge system privilege.

SourceBridge User’s Guide 23



Chapter 2: Using SourceBridge

SBM Data in the Source Control Tool

SourceBridge can record SBM association information in each file's source control
properties for some source control tools. This enables you to trace information related to
SBM items from within the source control tool. To enable this feature, select the Tag
Source Control Comment With Associations check box in your SourceBridge user settings.
For details see "Configuring User Settings" on page 10.

Each time a file is checked in or checked out and associated with an SBM item in the
integrated development environment, information about the item is added to the
comments entered. Depending on the action you are performing, these comments are
stored in the Comment field in the file's check out status properties or the file history
Comment field in the source control environment.

NOTE Comment fields are commonly used in source control applications that adhere to
the MSSCCI standard. They may be accessed differently or not at all, depending on the
development environment and source control applications being used.

By default, SourceBridge adds the SBM user's name, login ID, item ID, and comments to
the Comment field. Additional information is also stored with each Item ID to allow the

item to be uniquely identified in the SBM database. You can customize comment setting in
your SourceBridge user settings. For details see "Configuring User Settings" on page 10.

NOTE The number of characters that can be appended to the Comment field varies
depending on the source control application and the length of the comment entered when
the file is checked out. The data appended by SourceBridge may be truncated by the
source control application if the total length of the comment exceeds the maximum it
allows.
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